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Overview 
SCADALog is a user interface to the TelePACE DLOG or ISaGRAF dlogcnfg and dlog data 
logger functions. SCADALog reads data from a Controller and stores it in CSV files on your 
PC. Data can be read manually or automatically using command scripts. Data can be 
appended to an existing file or a new file can be created. Data can be viewed and printed 
from the SCADALog program. 

Data logs are created and defined using TelePACE or ISaGRAF applications. These 
programs specify the data that is logged and the format of the data. 

This manual provides full documentation on the SCADALog program. We strongly 
encourage you to read it, and to notify us if you find any errors or additional items you feel 
should be included in our documentation.  

Organization of the Manual 
This manual describes the SCADALog data log extraction program. It is organized into the 
following sections. 

Getting Started describes installation of the software. 

SCADALog Operation describes the process involved in creating a Ladder Logic 
application program for use with SCADALog. 

SCADALog Reference describes each command in the SCADALog program. 

Additional Documentation 
The on-line help for the SCADALog program contains a complete reference to the 
SCADALog program commands. To display on-line help, select Contents from the Help 
menu. 
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Getting Started 
To use SCADALog, you need to install the program on your system. The automated 
installation takes only a few minutes. 

Some virus checking software may interfere with Setup. If you experience problems with 
Setup, disable your virus checker and run Setup again. 

System Requirements 
The minimum system configuration for SCADALog is: 

• Personal computer using Pentium or higher microprocessor. 

• Microsoft Windows NT, Windows 2000 or Windows XP operating systems. 

NOTE:  Windows 95, 98 and ME operating systems are no longer supported. 

• Minimum 4 MB of memory. 

• Mouse or compatible pointing device. 

• Hard disk with approximately 1.0 Mbyte of free disk space. 

Making Backup Disks 
You should make a backup copy of the SCADALog disk before using the software. A backup 
copy protects you against damage to the disk. Always work with the backup copy – if it fails, 
you can make a new copy from the original disk. Store the original disk in a safe location. 

• In My Computer, click the icon for the disk you want to copy. 

• On the File menu, click Copy Disk. 

• Click the drive you want to copy from and the drive you want to copy to, and then click 
Start. 

Installation on a Hard Disk 
To install the SCADALog program: 

• Insert the SCADALog setup disk into CD drive. 

• Click the Windows Start button, and then click Run. 

• In the Open box, type d: setup and click OK. 

Follow the setup directions on the screen to install SCADALog. 

Running SCADALog Program 
To run the SCADALog program: 

• In the SCADALog group of the Program Manager, double click on the SCADALog icon. 
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SCADALog Operation 
This section of the manual is organized in a manner that will lead the new user through the 
steps required to create a data log in a SCADAPack controller or 4202GFC and extract the 
data logs using SCADALog. It is recommended that new users follow the steps outlined in 
the Creating a SCADALog Application section. 

The SCADALog Reference section has detailed explanations for all the commands and 
functions described in this section. In addition to this manual the on-line help for the 
SCADALog program contains a complete reference for the program.  

To display on-line help, select Contents from the Help menu. 

Creating a SCADALog Application 
SCADALog is used to extract data from logs that have been configured in a SCADAPack 
controller or 4202GFC. In order to log data a TelePACE or ISaGRAF application is created 
using the data logging functions.  

For TelePACE programs the DLOG function is used configure the data logging. For 
ISaGRAF applications the dlogcnfg and dlog functions are used. Follow the procedure in 
one of the first two steps, depending on the programming environment you are using, to 
create the data log in the SCADAPack controller of 4202GFC. Then follow the remaining 
steps to use SCADALog to retrieve data from these logs and then view, export and print this 
data. 

• Create a TelePACE Ladder Logic Application or,  

• Create an ISaGRAF Application  

• Read SCADALog Configuration from Controller 

• Read Logs from Controller 

• View Logged Data 

• Export Data to a Spreadsheet 

• Print Reports 

• Getting Help 

Create a TelePACE Ladder Logic Application 
Up to sixteen independent data logs can be configured in any ladder logic program. This 
example will illustrate how to create one data log only. The log will contain two data registers 
and a timestamp. To create a data logging ladder logic application: 

• Open TelePACE. 

• Select the New command from the File menu. 

• Select the Type command from the Controller menu. 

• Select the appropriate SCADAPack Controller. 

• Select the Register Assignment command from the Controller menu. 

• Select the Default button. 
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• Insert the following ladder logic elements in the first network:  

 
Digital input register 10001 enables the DLOG, digital Input 10002 grabs data and digital 
input 10003 deletes the data log. 

The DLOG element itself uses registers 41000 to 41017 for configuration and register 41018 
as the status. This DLOG is configured as log number 1. 

• Highlight the DLOG element with the cursor and select the Element Configuration 
command from the Edit menu. 

• Configure the DLOG Element Configuration dialog as follows. Refer to the TelePACE 
Ladder Logic User Manual for more information on configuring the DLOG function. 

 
This DLOG function will log up to 100 records each of registers 30001, 30002 and a 
timestamp. 

• Select the OK button to close the dialog. 

• Select the Save As command from the File menu to name and save this program to 
disk. 

• Select the Write to Controller command from the Communications menu and write 
the ladder logic application to the Controller. 

• Ensure that digital input registers 10001, 10002 and 10003 are off. 

• Select the Run command from the Operation menu. 
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• Select Monitor Online from the Activity menu. 

• Monitor status register 41018 as an unsigned variable. If this register does not appear in 
the monitor list, select the Monitor List command from the Edit menu and add register 
41018 to the Monitor Addresses field. Register 41018 should contain a 0. 

• Close digital input 10001 to enable the DLOG function. Register 41018 should now 
contain a 10 indicating that the log has been created. 

• Toggle digital input 10002 several times to log data. 

Create an ISaGRAF Application 
Up to sixteen independent data logs can be configured in any ISaGRAF application. There 
are two functions that are used in ISaGRAF to create a data log. 

• The dlogcnfg function is used to create the data log. 

• The dlog function is used to log data to the data log. 

This example will illustrate how to create one data log only. The log will contain three data 
registers and a timestamp. This example is not intended as a complete reference for 
creating ISaGRAF applications. Refer to the ISaGRAF User and Reference manual for 
complete information on creating projects and programs. To create a data logging ISaGRAF 
application: 

• Open ISaGRAF. 

• From the Project Management window select the New command from the File menu. 
Enter a suitable name for the new project; in the example the project is named 
LOGPROJ. 

• Double click the new file name in the project list to open the programs window. 

• From the Programs window select the New command from the File menu. Enter a 
suitable name for the new program; in the example the program is named FBDPROG 
and is a Function Block diagram type program. 

• From the Programs window select the I/O Connection command from the Project 
menu. Add a suitable I/O configuration for your controller type. 

• From the Programs window select the Dictionary command from the File menu. Add 
the following variables: 

Variable Type Initial Value 

enableCfg Boolean N/a 
deleteCfg Boolean N/a 
logID Integer 5 
maxRecords Integer 225 
numFields Integer 4 
boolType Integer 0 
intType Integer 3 
realType Integer 4 
daysType Integer 5 
enableSave Boolean N/a 
saveRecord Boolean N/a 
boolVar Boolean N/a 
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Variable Type Initial Value 

intVar Integer N/a 
realVar Real N/a 
saveError Boolean N/a 
saveStatus Integer N/a 
cfgStatus Integer N/a 
cfgError Boolean N/a 

• Create the data log as shown in the Create Data Log section and log data as shown in 
the Log Data section. 

Create Data Log 
The following example is used to create a data log with logID = 5. The input variables define 
the inputs to the dlogcnfg function block. 

• The maximum number of records in the log is 225 (maxRecords = 225).  

• The number of data fields is 4 (numFields = 4).  

• The first field is boolean (boolType = 0). 

• The second field is integer (intType = 3). 

• The third field is real (realType = 4). 

• The last field is days & hundredth seconds (daysType = 5).  

• The remaining field types are unused and may be set to 0. 
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Log Data 
The following example logs a record with four fields into the data log with logID=5. The log 
has been created using the dlogcnfg function block. The first and second fields are boolean 
and integer. These input variables must be converted into real type before connecting to the 
dlog inputs. The third field is Real; its input variable can connect directly to the input; The 
fourth field is days & hundredth seconds and is calculated by the function block. This input is 
ignored and may be set to 0.0. Fields 5 to field 8 are not used and may be set to 0.0. 
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Establish SCADALog Communication with the Controller 
The SCADALog program communicates with the Controller using one of your PC’s serial 
communication ports. Communication parameters are stored in the SCADALog file. When 
you open an existing file, the communication settings for your Controller are restored. A new 
file contains default settings, which may have to be changed if you altered Controller’s 
default serial port settings when loading the DLOG ladder logic application. 

To establish communication with the Controller: 

• Open SCADALog. 

• Select the New command from the File menu. 

• Select the PC Communication Settings command from the Communication menu. 

• Select the Protocol to use in the Communication Protocols Configuration and then 
click the Configure button to set the communication parameters. 

Refer to the SCADALog Reference section for more information. 

Read SCADALog Configuration from Controller 
Before extracting logged data from the Controller, SCADALog must read the configuration 
for each log in order to set up the required log windows and data fields.  

To read the DLOG configurations: 

• Select the Configuration command from the Data Log menu. 

• Select the Read button. A dialog will appear to inform you of the progress of the 
communication. 

• The Data Log Configuration dialog will now appear as: 
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The two data fields and time stamp field for Log 1 will be listed. 

• Select the OK button to close the dialog. 

Read Logs from Controller 
Data may now be read from the Controller logs and placed into their respective log windows.  

To read data logs from the Controller: 

• Select the Read Logs command from the Data Log menu. 

• On the Read Logs from Controller dialog, select either the All Logs or Selected Logs 
radio button. Due to the fact that only one log has been configured in this example, 
either selection will result in the same operation. 

• Select the Purge Logs after reading command if you want to erase the data from the 
Controller log after reading the data into SCADALog. 

• Select the OK button. 

• A dialog will appear indicating the progress of the communication by the entry number 
and the log number. 

• When all or selected logs have been read, the Read Logs dialog will appear 
summarizing the total number of new records added and duplicate records ignored. If 
the data log is read again, then any new records will be appended to the appropriate log 
window and any duplicate entries will be discarded.  

Note:  If data is being logged (grab data input on DLOG element) at a faster rate than 
being read from the Controller with SCADALog, then SCADALog will continuously 
read data. In this case, selecting Cancel on the Communication Progress dialog will 
stop the read operation and update the log windows with any data that was read. 

Save Logged Data and Configuration 
SCADALog saves the communication parameters, data log configuration and logged data in 
a set of files, (see Controller File Types for details). For convenience all files are saved 
with a single command. 

You should save the files after any change to configuration, or after reading the data logs 
from the Controller. 
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To save a SCADALog file, select the Save command from the File menu. 

When you save a file for the first time, SCADALog displays the Save As dialog box so you 
can name your file. You can also use the Save As command to change the name or 
directory of an existing file. 

Controller File Types 
SCADALog uses separate files for data log configuration and data. The table below 
indicates the file types and extensions. 

File Type File Contents Extension 
Configuration SCADALog Configuration SLC 
Data Logged data for view CSV 

 
• The configuration file name is used as the base for all file names. The configuration file 

is stored as filename.SLC. It includes the data log configuration read from the 
Controller, the column titles for each data log; and column sizes for each data log. 

• The data files are stored as filename-nn.CSV, where nn is a number from 01 to 16 
indicating logs numbered 1 to 16. 

View Logged Data 
Logged data, read from the Controller, is viewed using selections in the View menu. The 
View menu commands select which log’s data is to be displayed in the active window.  

Export Data to a Spreadsheet 
SCADALog can export the data in the data log configuration and the data from any view. 
Data is exported in the CSV (comma-separated values) format. This format can be read by 
most spreadsheet and database software. 

Data is exported from the current window. Select the window containing the view you wish to 
export or change the view in the current window using the View menu.  

To export data from a view: 

• Select the Export command From the File menu  

The Export data dialog appears for views that support the selection of records for exporting. 

The All selection exports all the data in the view. 

The Selection selection exports the data you have selected. You can select the records that 
interest you by clicking on them. 

• Click on the OK button. 

Refer to the SCADALog Reference for more information. 

Print Reports 
SCADALog can print the data in the Controller configuration and the data from any view. 
Data from views can be previewed before printing to see how the report will appear. Refer to 
the SCADALog Reference for more information. 
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To print data from a view 
• Select the window containing the view you wish to print or change the view in the current 

window using selections from the View menu. 

You can select the records that interest you by left-clicking the mouse button on them. 

• Select the Print command from the File menu. 

• The Printer controls let you select the printer and change it’s properties such as paper 
size and orientation. 

• The Print range controls let you select what to print. 

• The Copies control lets you select how many copies to print. 

• Click on OK to print the report. 

Clicking the Cancel button or pressing the Escape key closes the dialog. 

To preview a report from a view 
• Select the window containing the view you wish to print or change the view in the current 

window using selections from the View menu. 

You can select the records that interest you by left-clicking the mouse button on them. 

• Select the Print Preview command from the File menu. 

Changing the Print Setup 
The font, page headings, margins, and the size of the columns on the hourly history, daily 
history or event log reports can be changed.  

• To change the print set up select the Print Setup command from the File menu. 

Refer to the SCADALog Reference for more information. 

Getting Help  
The help file has a general description of how the program operates and can be used.  

• Select Contents from the Help menu to display SCADALog help. 
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SCADALog Reference 
This section of the user manual is a complete reference to the commands and display 
options of SCADALog. 

SCADALog Display 
The SCADALog display window is divided into the following areas. Each of the areas is 
described in the following sections of this manual. 

 
The Title Bar is located along the top of the SCADALog window and contains application file 
information and window control functions. 

The Menu Bar provides access to all SCADALog commands. This reference contains 
complete information on all SCADALog menu commands. 

The Tool Bar is located below the Menu Bar and provides quick mouse access to 
SCADALog functions.  

The Status Bar is displayed across the bottom of the application window and describes 
actions of menu items as you use the arrow keys or mouse to navigate through menus. 

Title Bar 
The title bar is located along the top of the window. It contains the name of the application 
SCADALog and the currently opened controller file. The current view and log number are 
displayed in brackets. 

The title bar provides commands for control of the opened application and the window 
display. 

To move the window, drag the title bar. You can also move dialog boxes by dragging their 
title bars. 

The application control menu button is the SCADALog icon in the left corner of the title bar. 
When selected the following commands are displayed.  
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Restore Command 
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command. 

Move Command 
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys. Note that this command is unavailable if you maximize the 
window. Using the mouse drag the window title bar to location required. 

Size Command 
Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys. This command is unavailable if you maximize the window. Use the mouse to 
drag the size bars at the corners or edges of the window.  

Minimize Command 
Use this command to reduce the SCADALog window to an icon. Use the mouse by clicking 
the minimize icon on the title bar. 

Maximize Command 
Use this command to enlarge the SCADALog window to fill the available space. Use the 
mouse by clicking the maximize icon on the title bar; or double-click the title bar. 

Close Command 
Use this command to close the active window or dialog box. Double-clicking a Control-menu 
box is the same as choosing the Close command.  If you have multiple windows open for a 
single document, the Close command on the document Control menu closes only one 
window at a time. You can close all windows at once with the Close command on the File 
menu. Keyboard keys CTRL+F4 closes a document window and ALT+F4 closes the 
SCADALog window or dialog box 

Tool Bar 
The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to many tools used in SCADALog. 

To hide or display the Toolbar, choose Toolbar from the View menu. 

The following commands and functions are displayed on the Toolbar.  

 Create a new file 

 Open an existing file. SCADALog displays the Open dialog box, in which you can 
locate and open the desired file. 

 Save the active file with its current name. If you have not named the document, 
SCADALog displays the Save As dialog box. 

 Print data from the active view. 

 View data, as it would be printed. 

 Edit data log configuration. 
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 Read Logs from Controller. 

 Show Log 1 in the current view. 

 Show Log 2 in the current view. 

 Show Log 3 in the current view. 

 Show Log 4 in the current view. 

 Show Log 5 in the current view. 

 Show Log 6 in the current view. 

 Show Log 7 in the current view. 

 Show Log 8 in the current view. 

 Show Log 9 in the current view. 

 Show Log 10 in the current view. 

 Show Log 11 in the current view. 

 Show Log 12 in the current view. 

 Show Log 13 in the current view. 

 Show Log 14 in the current view. 

 Show Log 15 in the current view. 

 Show Log 16 in the current view. 

The toolbar may:  

• remain stationary along one side of its parent window; 

• be dragged and docked, or attached, by the user to any side or sides of the parent 
window you specify; 

• be floated, or detached from the frame window, in its own mini-frame window so the 
user can move it around to any convenient position; and 

• be re-sized while floating. 

To move the toolbar, click on the background of the toolbar. Drag the toolbar to the new 
location and release the mouse button. 

Status Bar 
The Status Bar is displayed across the bottom of the application window. The left area of the 
status bar describes actions of menu items as you use the arrow keys to navigate through 
menus. It also shows messages that describe the actions of toolbar buttons as you depress 
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them, before releasing them. If after viewing the description of the toolbar button command 
you wish not to execute the command, then release the mouse button while the pointer is off 
the toolbar button. 

The right areas of the status bar indicate which of the following keys are latched down: 

CAP Indicates the Caps Lock key is latched down. 

NUM Indicates the Num Lock key is latched down. 

SCRL Indicates the Scroll Lock key is latched down. 

To hide or display the Status Bar, choose Status Bar from the View menu. 

Menu Bar 
The menu bar is displayed across the top of the application window, below the title bar. The 
menu bar provides access to all commands for control of the opened application and the 
window display. 

To move the window, drag the title bar. You can also move dialog boxes by dragging their 
title bars. 

The application control menu button is the SCADALog icon in the left corner of the menu 
bar. When selected the following commands are displayed.  

Restore Command 
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command. 

Move Command 
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys. Note that this command is unavailable if you maximize the 
window. Using the mouse drag the window title bar to location required. 

Size Command 
Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys. This command is unavailable if you maximize the window. Use the mouse to 
drag the size bars at the corners or edges of the window.  

Minimize Command 
Use this command to reduce currently active window to an icon. Use the mouse by clicking 
the minimize icon on the title bar. 

Maximize Command 
Use this command to enlarge the currently active window to fill the available space. Use the 
mouse by clicking the maximize icon on the title bar; or double-click the title bar. 

Close Command 
Use this command to close the active window or dialog box. Double-clicking a Control-menu 
box is the same as choosing the Close command.  If you have multiple windows open for a 
single document, the Close command on the document Control menu closes only one 
window at a time. You can close all windows at once with the Close command on the File 
menu. Keyboard keys CTRL+F4 closes a document window and ALT+F4 closes the 
SCADALog window or dialog box 
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Next Window Command 
Use this command to switch to the next open document window. SCADALog determines 
which window is next according to the order in which you opened the windows. Use the 
keyboard keys CTRL+F6. 

Refer to the Menu Commands section for more information. 

Menu Commands 
The Menu Bar displays the SCADALog Menu selections available. Selecting a menu opens 
a list of commands available for that menu. Each of the commands is described in the 
following sections of this manual. 

File Menu 
The File commands menu contains commands to create, open and save SCADALog files. 
File menu commands allow data to be exported to spreadsheet files and to be printed. 

New Command 
Use this command to create a new SCADALog file. When a file is created all log 
configurations are set to default values. All logs contain no information.  

Any open windows are retained. If no windows are open, one window is opened with a view 
of log 1. 

Open Command 
Use this command to open an existing SCADALog file. When the Open command is used 
the File Open Dialog is displayed. The following options allow you to specify which file to 
open. 

The Look in: box lists the available folders and files.  

The File name: box allows you to type or select the filename you want to open. This box 
lists files with the extension you select in the Files of Type box. 

The Files of type: box lists the types of files SCADALog can open. SCADALog can open 
SCADALog (SLC) files. 

The Open command closes all views for logs that are not configured for the file that is 
opened. 

Only one file can be open at a time in SCADALog. To view data from more than one 
controller at a time, start another copy of SCADALog. 

Close Command 
Use this command to close all SCADALog windows for the controller. SCADALog suggests 
that you save changes If you close a SCADALog file without saving, you lose all 
configuration changes made and logs that have been read from the controller since the last 
time you saved it. Before closing an untitled file, SCADALog displays the SCADALog dialog 
box and suggests that you name and save the file. 

Save Command 
Use this command to save the SCADALog file to its current name and directory. Saving a 
file saves the SCADALog configuration and data logs. 
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When you save a file for the first time, SCADALog displays the Save As dialog box so you 
can name your file. If you want to change the name or directory of the file, before you save 
it, choose the Save As command. 

Save As Command 
Use this command to save and name the SCADALog file. SCADALog displays the Save As 
dialog box so you can name your file. The following options allow you to specify the name 
and location of the file you're about to save: 

The Save in: box lists the available folders and files. 

The File name: box allows entry of a new filename to save a file with a different name. 
SCADALog adds the extension you specify in the Save As type box. 

The Save as type: box lists the types of files SCADALog can save. SCADALog can open 
Controller (TFC) files. 

The Save button saves the file to the specified location. 

The Cancel button closes the dialog without saving. 

To save a file with its existing name and directory, use the Save command.  

The data will be exported in sequence number order. 

SCADALog File Types 
SCADALog uses separate files for data log configuration and data. The table below 
indicates the file types and extensions.  

File Type File Contents Extension 
Configuration SCADALog Configuration SLC 
Data Logged data for view CSV 
Log Results Results of data logging LOG 

 
The configuration file name is used as the base for all file names.  

• The configuration file is stored as filename.SLC.  

• The data files are stored as filename-nn.CSV, where nn is a number from 01 to 16. 

• The log results are stored as filename.LOG. 

Managing SCADALog Files 
When copying SCADALog files from one PC to another, copy all the files for a controller. 

If data logs have grown too large, move the log files to another directory. New files will be 
created the next time you read logs from the controller. If you export the data first, you can 
have easy access to the archived data from a spreadsheet and current data from 
SCADALog. 

If you have created a copy of a SCADALog configuration for of a new controller, you can 
delete the logs by deleting the files with the CSV extensions. 

Export command 
Use the Export command to export data from any data log. Data is exported in the CSV 
(comma-separated values) format. This format can be read by most spreadsheet and 
database software. The column headings are taken from the configured titles for the data 
log. 
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Data is exported from the current window. Select the window containing the data you wish to 
export, then select the Export command. 

The following options allow you to specify the data to export. 

The All radio button selects all the data in the current view. This is the default button if no 
data is selected. 

The Selection radio button selects the data that is currently selected in the view. This is the 
default button if data is selected. 

Clicking the Cancel button or pressing the Escape key closes the dialog. 

The OK button exports the selected data. It opens the Save As file selection dialog, with the 
file type CSV active.  

The Save As file selection dialog appears for views that do not support the selection of 
records such as configuration views. The Save As dialog allows you to specify the file to 
export the data to. If the file exists, then the exported data is appended to the file. 

The OK button in the Save As dialog exports the data to the selected file.  

The Cancel button in the Save As dialog cancels the export command and closes all 
dialogs. 

Print Command 
Use this command to print reports from the current view. SCADALog displays the Print 
dialog box. The following options allow you to specify the printer, the print range and the 
number of copies.  

The Name drop-down list box displays a list of configured printers. 

The Properties button defines the settings for the selected printer. 

The Print range radio buttons selects the data to be printed. 

The All radio button prints all the data in the current view. This is the default button if no data 
is selected. 

The Pages radio button allows the printing of selected pages. 

The Selection radio button prints the data that is currently selected in the view. This is the 
default button if data is selected. 

The Number of copies selection indicates how many copies to print. 

If the printer selected in the Name box supports collating print jobs you may select Collate, 
otherwise the control is grayed.  

The OK button prints the report. 

Selecting the Cancel button or pressing the Escape key closes the dialog. 

Print Preview Command 
Use this command to see how your printed report will look. The command opens a special 
view that shows data, as they will be printed.  

To preview a report from a view select the window containing the view you wish to print 
using selections from the View menu. 

You can select records to print that interest you by left-clicking the mouse button on them. 

A row of control buttons is available at the top of this view. These control buttons are 
described below. 
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The Print button prints the report as shown. 

The Next Page button displays the next page. It is grayed if there are no more pages. 

The Prev Page button displays the previous page. It is grayed if there are no pages before 
the current page. 

The Two Page button changes the display to show two pages at a time. The One Page 
button changes the display to show one page at a time. 

The Zoom In button enlarges the page displayed so you can see details on the report. 

The Zoom Out button shrinks the page displayed so you see how the page is formatted. 

The Close button closes the Print Preview view. 

Print Setup Command 
Use this command to define how reports are printed. The font, page headings, margins, and 
the size of the columns on the reports can be changed. Select from the options described 
below. 

The Page Headings section selects what is printed in the header of each report page. 

Selecting Title prints the title of the report centered on the page. 

Selecting Date and Time prints the date and time in the upper left-hand corner of the page. 
The date and time are printed in the long time format defined from the Windows Control 
Panel. 

Selecting Page Numbers prints “Page” and the page number in the upper right hand corner 
of the page. 

The Start At edit box selects where the page numbers start. 

The Margins section defines the page margins. 

Left is the size of the left-hand margin on the page. 

Right is the size of the right hand margin on the page. 

Top is the size of the top margin on the page. 

Bottom is the size of the bottom margin on the page. 

Measurement Units is the units of measurement for the margins. It is one of Inches or mm. 
The units are converted into the other measurement system when this control is changed. 

The selected font section defines the font used for printing reports. The currently selected 
font is shown.  

The Change Font button opens a font selection dialog. The user may choose the font for 
printing reports. Column widths are chosen automatically using the selected font. 

Select the OK button to use the new settings. 

Select the Cancel button or press the Escape key to close the dialog. 

The Printer button opens the Printer dialog. 

The Help button displays help for this dialog. 

Recent Files List 
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
files you closed. Choose the number that corresponds with the file you want to open. 
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Exit Command 
Use this command to exit from SCADALog. If changes have been made to the configuration 
or data log files, you will be asked if you want to save them. 

Edit Menu 
The edit menu commands allow selected data to be copied to the clipboard. The selected 
data is then available for use in other applications.  

Copy Command 
Use this command to copy selected data onto the clipboard. This command is unavailable if 
the view does not contain data that can be selected. Copying data to the clipboard replaces 
the contents previously stored there. 

Select All Command 
Use this command to select all the records in the current view. This command is unavailable 
if the view does not contain data that can be selected. 

View Menu 
The view menu commands select the data that is displayed in the active window. The 
visibility of the Toolbar and Status Bar is controlled from the view menu. 

Log 1, Log 2, … Log 16 Commands 
Use these commands to change the log in the current window. 

Commands for logs that are not configured in the current file are grayed. 

The data log view may be modified using the following options. 

Sorting Data 
Clicking on the column headings will sort the table, in ascending order, according to the 
column selected. Clicking subsequent times on the same column toggles the sort order 
between descending and ascending order. 

Sizing Columns 
Positioning the cursor over the line separating the columns in the heading can change the 
column widths. The cursor changes to a vertical bar with arrows pointing left and right. Click 
on the line, then slide the mouse left or right. Release the mouse button when the column is 
the desired width. 

Selecting Data 
Click on any row to select it. Hold down Shift and click on any row to select the range from 
the currently selected row to the new row. Hold down Ctrl and click on any row to toggle the 
selection of that row. 

Printing and Exporting Data 
To print or export part of the data, select the desired rows then use the Print or Export 
function. 
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Toolbar Command 
Use this command to display or hide the Toolbar, which includes buttons for some of the 
most common commands in SCADALog. A check mark appears next to the menu item when 
the Toolbar is displayed. 

Status Bar Command 
Use this command to display or hide the Status Bar. The Status bar appears at the bottom of 
the main window. It displays information about the command selected and other status 
information. A check mark appears next to the menu item when the Status Bar is displayed. 

See Status Bar section for help on using the status bar. 

Data Log Menu 
The Data Log menu contains the commands for configuring views and reading data logs 
from the controller. 

Configuration Command 
Use this command to read data log configurations from the controller and to rename column 
titles on the data log view. Initially the column titles in the log are named Value 1, Value 2, 
etc. You can change these titles to describe the actual logged values. Each log has different 
titles for its columns. 

 
The Controller ID shows the ID of the controller where the data logs are configured. 

The Log Number list box selects which data log to edit. The list box below it shows the 
values and their names for the selected log. 

The OK button saves the modified settings and closes the Configuration dialog. 

The Cancel button closes the Configuration dialog and discards any changes. 

The Read button reads all data log configuration from a controller. 

The Edit Title button edits column titles. 

The Help button displays help for the dialog. 
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Reading Configuration 
Initially no columns are defined for a log. Use the Read button to read data log configuration 
from a controller, or to update the configuration with new information from the controller. The 
configuration is defined using TelePACE.  

If the controller ID does not match the controller ID in the file, SCADALog displays the 
message “Error: The controller ID in the controller and file do not match.” If this occurs, close 
the current file, open a new file and repeat the operation. 

If the configuration that is read from the controller is not compatible with data already in the 
logs, SCADALog will abort the read and display the message “Error: The log configuration in 
the controller and file do not match.” If this occurs, close the current file, open a new file and 
repeat the operation. 

If the controller firmware does not support the DLOG element, SCADALog displays the 
message “Error: The controller firmware does not support the required functions”. 

Editing Titles 
The Log Number list box selects which data log to edit. Only the logs that are defined for 
the current controller are listed. 

The titles for the selected log are displayed in a list box. Select the title you wish to edit and 
click on the Edit Title button.  

The Edit Title button opens the following dialog. It shows the log number, field number, type 
of data in the column and column title. 

 
The Title edit box changes the column title. Enter a title up to 16 characters in length. 

The OK button saves the modified settings and closes the Configuration dialog. 

The Cancel button closes the Configuration dialog and discards any changes. 

The Help button displays help for the dialog. 

Communication Progress Dialog 
The Communication Progress dialog is displayed when SCADALog is reading configuration 
data from the controller. The dialog indicates the operation occurring in the dialog text.  

Read Logs Command 
Use this command to read data logs from the controller. This command is disabled when the 
PC Communication Settings are set to Dial Up and the controller is not connected. 
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The radio buttons determine which log is read from the controller. 

• Select All Logs to read all logs from the controller. This button is selected by default. 

• Select Selected Log to read a single log. Select the log to be read from the list box. 
Only the logs that are configured in the controller are read. 

• Select Script File to manually execute a pre-configured SCADALog command script 
file. The file name of the script file to be executed can be entered into the Script File 
edit box or the Browse command can be used to search for an existing script file. The 
script file displayed in the Script File edit box can be viewed by selecting the View 
command. A list box is opened and a list of commands displayed.  

The Purge logs after reading check box selects if readings are removed from the data logs 
in the controller after they are read. If you select this option, be sure to save the SCADALog 
file afterwards. Otherwise the data will be lost. This option is not selected by default. 

The OK button reads the selected logs from the controller or executes the script command 
file and closes the dialog. 

The Cancel button closes the dialog. 

The Help button displays help for the dialog. 

If the controller ID in the file and controller do not match, SCADALog displays the message 
“Error: The controller ID in the controller is different than the open file”. 

If the configuration in the file and controller do not match, SCADALog displays the message 
“Error: The log configuration in the controller is different than the open file”. 

If no data logs are configured in the controller, SCADALog displays the message “Error: The 
log configuration in the controller is different than the open file”. 

The All Logs radio button will be selected. The Purge log after reading control will be 
unchecked. 

Notes 
Each record in a log has a sequence number. If SCADALog reads a record from a controller 
with the same sequence number as one already in the file, it is not added to the file. 

This number is unique under most conditions. It will repeat after 4,294,967,295 records have 
been recorded to the log. This will occur once every 136 years if records are recorded once 
per second. In this case, create a new SCADALog file to read and save the records. 

The sequence number is reset to zero when a log is deleted or the controller is initialized. In 
these cases you must create a new SCADALog file to read and save the records. 
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Communication Progress Dialog 
The Communication Progress dialog is displayed when SCADALog is reading data logs 
from the controller. The dialog indicates the operation occurring in the dialog text.  

 
Note: If data is being logged (grab data input on DLOG element) at a faster rate than being 
read from the Controller with SCADALog, then SCADALog will continuously read data. In 
this case, selecting Cancel on the Communication Progress dialog will stop the read 
operation and update the log windows with any data that was read. 

Read Logs Dialog 
The Read Logs dialog is displayed when all logs have been read from the controller. The 
dialog indicates the total number of new records added and the total number of duplicate 
records ignored. 

 

Edit Script Command 
Use this command to edit SCADALog script commands. Scripts are text files that contain a 
list of SCADALog commands. The script files can be executed either manually, (under direct 
control of the user) or automatically, (under control of another program). 
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This command edits and saves script files that can be accessed by all SCADALog 
applications. The script file is not related to the currently open SCADALog application. The 
script command line determines which SCADALog application executes which script file. 

The Edit Script dialog consists of the currently opened script filename, a list of commands 
configured in the opened script, script configuration command buttons and Edit Script dialog 
command buttons. 

The currently opened script filename displays the filename of the currently opened script file. 
The format is X:\….…\filename.aut, where X is the disk drive letter assignment, \……\ 
is the subdirectory or subdirectories where the script file is located, filename is the script 
filename and .aut is the filename extension. In the above example the opened script file is 
called slogdemo.aut and is located on the C: drive in the SLOGDEMO subdirectory. When 
the Edit Script command is selected, a script file is not yet open. The filename is displayed 
as [untitled file] in this case. 

The configured command list displays the commands that have be configured for the open 
script file. These commands are configured with the Add and Edit commands and are 
executed in the order that they appear in the command list. Listed commands may be acted 
upon by selecting the particular command with the cursor and then executing one of the 
script configuration commands. 

The script configuration commands are used to configure the script file. 

• The Add command opens the Edit Script Command dialog for the configuring of a new 
script command. 

 
The Script command field displays the currently selected script command as determined by 
the Command field. 

The Command drop down menu displays the list of available commands for selection. 
Selecting the arrow icon with the cursor will make these commands visible for selecting. The 
commands are:  

• Read All. Use this command to read all configured data logs from the controller. 

• Read Log. Use this command to read only one data log from the controller. The log 
number is specified in the Log field. 

• Save. Use this command to save the SCADALog application and to automatically save 
the logged data to csv files. 

• Exit. Use this command to close SCADALog. 

The Log drop down menu displays the log number to be read when the Read Log command 
has been selected. This field is grayed for all other commands. 

The Purge drop down menu displays the log-purge mode for the Read and Read All 
commands. Selecting Yes configures SCADALog to purge the log/logs after they have been 
read. Selecting No configures SCADALog to not purge the log/logs after they have been 
read. This field is grayed for the Save and Exit commands. 
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The OK button retains the settings for the current script command and closes the Edit Script 
Command dialog. 

The Cancel button discards any new changes to the current script command and closes the 
Edit Script Command dialog. 

The Help button displays help for the dialog. 

• The Edit command opens the Edit Script Command dialog to edit the currently selected 
command. This command will appear in both the Script command and Command fields 
in the Edit Script Command dialog. See the Add command for details on the Edit Script 
Command dialog. This command is grayed if the command list is empty. 

• The Delete command removes the currently selected command from the command list. 
This command is grayed if the command list is empty. 

• The Delete All command removes all commands from the command list. This command 
is grayed if the command list is empty. 

• The Move Up command moves the currently selected command up one position in the 
command list. This command is grayed if the command list is empty or if top command 
in the list is selected. 

• The Move Down command moves the currently selected command down one position 
in the command list. This command is grayed if the command list is empty or if the 
bottom command in the list is selected. 

The edit script dialog commands are used to manage the script files for editing. 

The Close command closes the Edit Script dialog. If a script file has been configured but not 
yet saved, a dialog will appear prompting the user to save the changes to a script file. The 
Save As dialog is displayed. (see the Save As command section for more information.) 

The Open command opens an existing script file for editing. If the current command list has 
not yet been saved to a script file, a dialog will appear prompting the user to save the 
changes to a script file. When the Open command is used the Open dialog is displayed. The 
following options allow the user to specify which file to open. 

• The Look in: box lists the available folders and files.  

• The File name: box allows you to type or select the filename you want to open. This box 
lists files with the script file extension “aut”. 

• The Files of type: box displays the only type of file that this command can open: 
SCADALog script files, with the file extension “aut”. 

• The Open command opens the script file that is displayed in the File name: box and 
closes the Open dialog. The commands contained in the script file are displayed in the 
command list. 

• The Cancel command cancels the Open command and closes the Open dialog. 

The Save command saves the currently open script file. This command is grayed if the script 
file has not been saved using the Save As command. 

The Save As command saves the current command list to either an existing or new script 
file. This command is grayed if the command list is empty. 

The Save As dialog is displayed with the following options to allow the user to specify the 
script file name. 

• The Save in: box lists the available folders and files.  

• The File name: box allows you to type or select the filename you want to save.  
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• The Save as type: box displays the only type of file that this command can save: 
SCADALog script file, with the file extension “aut”. 

• The Save command saves the current command list to the script file specified in the File 
name: box and closes the Save dialog. 

• The Cancel command cancels the Save As command and closes the Save As dialog. 

The Help button displays help for the dialog. 

Log Results Command 
The Log Results command allows the user to set if the results of the script command 
execution is logged or not. When the Log Results menu is checked, all the results of the 
script-enabled SCADALog operations will be written into a log file. See the Script Log 
section for more information. 

Communication Menu 
The Communication menu contains the commands for configuring the communication 
between the Flow Computer and RealFLO. 

PC Communications Settings Command 
The PC Communication Settings command defines the communication protocol and 
communication link used for communication between the personal computer (PC) and 
SCADAPack or 4202 series controllers.  

When the command is select the Communication Protocols Configuration dialog is displayed 
as shown below. 

 
The Communication Protocols drop down list box presents all available communication 
protocols. The default protocol is Modbus RTU. Click the drop down list icon at the right of 
the window to display a list of available communication protocols. 

• ClearSCADA 
• DNP 
• Modbus ASCII 
• Modbus ASCII in TCP 
• Modbus ASCII in UDP 
• Modbus RTU 
• Modbus RTU in TCP 
• Modbus RTU in UDP 
• Modbus/TCP 
• Modbus/UDP 
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• Modbus/USB 
• SCADAServer 

The Configure button opens configuration dialog for the selected communication protocol. 

The RealFLO Command Timeout edit box sets the length of time, in seconds, to wait for a 
response to a RealFLO command. The valid range is 3 to 60 seconds and the default value 
is 10. 

Clicking the OK button will make the selected protocol the active one.  

Clicking the Cancel button abandons any and all changes made via this dialog. 

 

ClearSCADA 
The ClearSCADA protocol driver is used for communicating with a local or remote 
ClearSCADA server.  The ClearSCADA server will then, in turn, communicate with devices 
as per its configuration.  The ClearSCADA protocol driver communicates with the 
ClearSCADA server using a TCP connection. 

• To configure a ClearSCADA protocol connection, highlight ClearSCADA in the 
Communication Protocols window and click the Configure button. The ClearSCADA 
Configuration window is displayed. 

• To select a configured ClearSCADA protocol connection, highlight ClearSCADA in the 
Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When ClearSCADA protocol is selected for configuration the ClearSCADA Configuration 
dialog is opened with the General tab selected as shown below. 

 
The General tab component information section contains the name of Communication 
Component and the author, Control Microsystems. 
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The Communications Settings grouping contains all the essential details necessary to 
establish communication to a device through a local or remote ClearSCADA installation.  

The Modbus Station entry specifies the station address of the target device. Valid values 
are 1 to 65534. 

The Outstation Set entry specifies the ClearSCADA outstation set to which the target 
device is attached. The valid range is 0 to 65535. The default value is 0. 

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

 0.0.0.0 through 0.255.255.255 

127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The TCP Port Number entry specifies the TCP port on the ClearSCADA server. The valid 
range is 0 to 65535. The default value is 49155 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field.  The contents of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 
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The Custom Value selection specifies a custom value for the message size. This value will 
indicate to the host application to package messages to be no larger than what is specified, 
if it is possible. Allowable values range from 2-264. However, values greater that 260 will 
cause corrupted logs to be returned by SCADALog.     

NOTE:  The packet size should be less than or equal to 260 bytes.  

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

DNP 
The DNP protocol driver is used to communicate over a serial DNP network to SCADAPack 
controllers configured for DNP communication.  

• To configure a DNP protocol connection, highlight DNP in the Communication Protocols 
window and click the Configure button. The DNP Configuration window is displayed. 

• To select a configured DNP protocol connection, highlight DNP in the Communication 
Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 
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General Parameters 
When DNP is selected for configuration the DNP Configuration dialog is opened with the 
General tab selected as shown below.  

 
The General tab component information section contains the name of Communication 
Component and the author, Control Microsystems. 

The DNP Communication Settings logical grouping contains DNP specific communication 
settings including the DNP Station address, the timeout interval as well as the number of 
attempts.  

The RTU Station parameter sets the target DNP station number. Valid entries are 0 to 
65519. The default address is 1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

This Serial Port Settings grouping contains details directly related to the PC’s 
communication port including the port number, the baud rate, parity and stop bit settings.  

The Port parameter specifies the PC serial port to use. The DNP driver determines what 
serial ports are available on the PC and presents these in the drop-down menu list. The 
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available serial ports list will include any USB to serial converters used on the PC. The 
default value is the first existing port found by the driver.  

The Baud parameter specifies the baud rate to use for communication. The menu list 
displays selections for 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, and 57600. The 
default value is 9600. 

The Parity parameter specifies the type of parity to use for communication. The menu list 
displays selections for none, odd and even parity. The default value is None. 

The Stop Bits parameter specifies the number of stop bits to use for communication. The 
menu list displays selections for 1 and 2 stop bits. The default value is 1 bit. 

The Connection Type parameter specifies the serial connection type. The DNP driver 
supports direct serial connection with no flow control, Request-to-send (RTS) and clear-to-
send (CTS) flow control and PSTN dial-up connections. The menu list displays selections 
for Direct Connection, RTS/CTS Flow Control and Dial Up Connection. The default selection 
is Direct Connection. 

• Select Direct Connection for RS-232 for RS-485 connections that do not require the 
hardware control lines on the serial ports.  

• Select RTS/CTS Flow Control to communicate over radio or leased-line networks using 
modems that require RTS/CTS handshaking. Selecting RTS/CTS Flow Control adds a 
new tab, Flow Control, to the DNP Configuration dialog. Refer to the Flow Control 
Parameters section below for configuration details.  

• Select Dial Up Connection to communication over dial up modems. Selecting Dial Up 
Connection adds a new tab, Dial Up, to the DNP Configuration dialog. Refer to the Dial 
Up Parameters section below for configuration details. 

• Click Restore Defaults to restore default values to all fields on this page. 

Flow Control Parameters 
Flow Control parameters are used to configure how RTS and CTS control is used. When 
RTS/CTS Flow Control is selected for Connection Type the Flow Control tab is added to the 
DNP Configuration dialog.  When the Flow Control tab heading is clicked the Flow Control 
dialog is opened as shown below. 
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RTS/CTS Flow Control 
The RTS/CTS Flow Control grouping contains two mutually exclusive options, Use 
Hardware Control Lines and Use CTS Delay Time.  These options enable the driver to 
communicate over radio or leased-line networks using modems that require RTS/CTS 
handshaking.  

The Use Hardware Control Lines option specifies a half-duplex connection requiring the 
use of the Request to Send (RTS) and Clear to Send (CTS) hardware control lines to control 
the flow of data. This selection is used with radios and dedicated telephone line modems. 
The driver turns on the RTS signal when it wants to transmit data. The modem or other 
device then turns on CTS when it is ready to transmit. The driver transmits the data, and 
then turns off the RTS signal. This selection is mutually exclusive of the Use CTS Delay 
Time selection described below. This is the default selection. 

The Use CTS Delay Time option is selected if the device cannot generate a CTS signal. 
The driver will assert RTS then wait the specified Delay Time, in milliseconds, before 
proceeding.  This option is mutually exclusive with the Use Hardware Control Lines selection 
described above. 

The Delay Time parameter sets the time in milliseconds that the driver will wait after 
asserting RTS before proceeding. The value of this field must be smaller than the Time Out 
value set in the General parameters dialog. For example, if the Timeout value is set to 3 
seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 
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The Hold Time parameter specifies the time, in milliseconds, that the driver will hold RTS 
after the last character is transmitted. This is useful for devices that immediately end 
transmission when RTS is turned off. The value of this field must be smaller than the Time 
Out value set in the General parameters dialog. For example, if the Timeout value is set to 3 
seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 

• Click Restore Defaults to restore default values to all fields on this page. 

Dial Up Parameters 
Dial Up parameters are used to configure a dial up connection. When Dial Up is selected for 
Connection Type the Dial Up tab is added to the DNP Configuration dialog.  When the Dial 
Up tab heading is clicked the Dial Up dialog is opened as shown below. 

 
The Dialing Prefix parameter specifies the commands sent to the modem before dialing. A 
maximum of 32 characters can be entered. All characters are valid. The default value is 
“&F0 &K0 S0=1 &W0 &Y0”. 

The Phone Number parameter specifies the telephone number of the remote controller. A 
maximum of 32 characters can be entered. All characters are valid. This field’s default value 
is blank. 

The Dial Type parameter specifies the dialing type. Valid values are Pulse and Tone. The 
default value is Tone. 

The Dial Attempts parameter specifies how many dialing attempts will be made. Valid 
values are 1 to 10. The default value is 1.  
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The Connect Time parameter specifies the amount of time in seconds the modem will wait 
for a connection. Valid values are 6 to 300. The default value is 60. 

The Pause Time parameter specifies the time in seconds between dialing attempts. Valid 
values are 6 to 600. The default value is 30. 

Check the Inactivity Timeout check box to automatically terminate the dialup connection 
after a period of inactivity. The Inactivity Time edit box is enabled only if this option is 
checked. The default state is checked. 

Enter the inactivity period, in minutes, in the Inactivity Timeout box. The dialup connection 
will be terminated automatically after the specified number of minutes of inactivity has 
lapsed. This option is only active if the Inactivity Timeout box is checked. Valid values are 
from 1 to 30 minutes. The default value is 1. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
Phone Number field. The content of this field will remain unchanged. 

Advanced Parameters 
DNP Configuration Advanced parameters set the DNP master station address and message 
size control. When the Advanced tab heading is clicked the Advanced dialog is opened as 
shown below. 

 
The Master Station parameter is the DNP station address assumed by this communication 
component. When this driver sends out commands, responses form the controller will be 
directed to this address. The default value is 100. 
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The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible. Valid values are 2 to 231. The default value is 231. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 
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Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus ASCII 
The Modbus ASCII protocol driver is used to communicate over a serial network, using 
Modbus ASCII framing, to SCADAPack controllers configured for Modbus ASCII protocol.  

• To configure a Modbus ASCII protocol connection, highlight Modbus ASCII in the 
Communication Protocols window and click the Configure button. The Modbus ASCII 
Configuration window is displayed. 

• To select a configured Modbus ASCII protocol connection, highlight Modbus ASCII in 
the Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus ASCII is selected for configuration the Modbus ASCII Configuration dialog is 
opened with the General tab selected as shown below.  
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The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

This Serial Port Settings grouping contains details directly related to the PC’s 
communication port including the port number, the baud rate, parity and stop bit settings.  

The Port parameter specifies the PC serial port to use. The DNP driver determines what 
serial ports are available on the PC and presents these in the drop-down menu list. The 
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available serial ports list will include any USB to serial converters used on the PC. The 
default value is the first existing port found by the driver.  

The Baud parameter specifies the baud rate to use for communication. The menu list 
displays selections for 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, and 57600. The 
default value is 9600. 

The Parity parameter specifies the type of parity to use for communication. The menu list 
displays selections for none, odd and even parity. The default value is None. 

The Data Bits parameter specifies the number of data bits contained in the character frame. 
Valid values are for this field is 7 and 8 bits. The default value is 8 bits. 

The Stop Bits parameter specifies the number of stop bits to use for communication. The 
menu list displays selections for 1 and 2 stop bits. The default value is 1 bit. 

The Connection Type parameter specifies the serial connection type. The Modbus ASCII 
driver supports direct serial connection with no flow control, Request-to-send (RTS) and 
clear-to-send (CTS) flow control and PSTN dial-up connections. The menu list displays 
selections for Direct Connection, RTS/CTS Flow Control and Dial Up Connection. The 
default selection is Direct Connection. 

• Select Direct Connection for RS-232 for RS-485 connections that do not require the 
hardware control lines on the serial ports.  

• Select RTS/CTS Flow Control to communicate over radio or leased-line networks using 
modems that require RTS/CTS handshaking. Selecting RTS/CTS Flow Control adds a 
new tab, Flow Control, to the Modbus ASCII Configuration dialog. Refer to the Flow 
Control Parameters section below for configuration details.  

• Select Dial Up Connection to communication over dial up modems. Selecting Dial Up 
Connection adds a new tab, Dial Up, to the Modbus ASCII Configuration dialog. Refer to 
the Dial Up Parameters section below for configuration details. 

• Click Restore Defaults to restore default values to all fields on this page. 

Modbus ASCII Configuration (Flow Control) 
Flow Control parameters are used to configure how RTS and CTS control is used. When 
RTS/CTS Flow Control is selected for Connection Type the Flow Control tab is added to the 
Modbus ASCII Configuration dialog.  When the Flow Control tab heading is clicked the Flow 
Control dialog is opened as shown below. 
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The RTS/CTS Flow Control grouping contains two mutually exclusive options, Use 
Hardware Control Lines and Use CTS Delay Time.  These options enable the driver to 
communicate over radio or leased-line networks using modems that require RTS/CTS 
handshaking.  

The Use Hardware Control Lines option specifies a half-duplex connection requiring the 
use of the Request to Send (RTS) and Clear to Send (CTS) hardware control lines to control 
the flow of data. This selection is used with radios and dedicated telephone line modems. 
The driver turns on the RTS signal when it wants to transmit data. The modem or other 
device then turns on CTS when it is ready to transmit. The driver transmits the data, and 
then turns off the RTS signal. This selection is mutually exclusive of the Use CTS Delay 
Time selection described below. This is the default selection. 

The Use CTS Delay Time option is selected if the device cannot generate a CTS signal. 
The driver will assert RTS then wait the specified Delay Time, in milliseconds, before 
proceeding.  This option is mutually exclusive with the Use Hardware Control Lines selection 
described above. 

The Delay Time parameter sets the time in milliseconds that the driver will wait after 
asserting RTS before proceeding. The value of this field must be smaller than the Time Out 
value set in the General parameters dialog. For example, if the Timeout value is set to 3 
seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 

The Hold Time parameter specifies the time, in milliseconds, that the driver will hold RTS 
after the last character is transmitted. This is useful for devices that immediately end 
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transmission when RTS is turned off. The value of this field must be smaller than the Time 
Out value set in the General parameters dialog. For example, if the Timeout value is set to 3 
seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 

• Click Restore Defaults to restore default values to all fields on this page. 

Modbus ASCII Configuration (Dial Up) 
Dial Up parameters are used to configure a dial up connection. When Dial Up is selected for 
Connection Type the Dial Up tab is added to the Modbus ASCII Configuration dialog.  When 
the Dial Up tab heading is clicked the Dial Up dialog is opened as shown below. 

 
The Dialing Prefix parameter specifies the commands sent to the modem before dialing. A 
maximum of 32 characters can be entered. All characters are valid. The default value is 
“&F0 &K0 S0=1 &W0 &Y0”. 

The Phone Number parameter specifies the telephone number of the remote controller. A 
maximum of 32 characters can be entered. All characters are valid. This field’s default value 
is blank. 

The Dial Type parameter specifies the dialing type. Valid values are Pulse and Tone. The 
default value is Tone. 

The Dial Attempts parameter specifies how many dialing attempts will be made. Valid 
values are 1 to 10. The default value is 1.  
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The Connect Time parameter specifies the amount of time in seconds the modem will wait 
for a connection. Valid values are 6 to 300. The default value is 60. 

The Pause Time parameter specifies the time in seconds between dialing attempts. Valid 
values are 6 to 600. The default value is 30. 

Check the Inactivity Timeout check box to automatically terminate the dialup connection 
after a period of inactivity. The Inactivity Time edit box is enabled only if this option is 
checked. The default state is checked. 

Enter the inactivity period, in minutes, in the Inactivity Timeout box. The dialup connection 
will be terminated automatically after the specified number of minutes of inactivity has 
lapsed. This option is only active if the Inactivity Timeout box is checked. Valid values are 
from 1 to 30 minutes. The default value is 1. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
Phone Number field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 
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The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 
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The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus ASCII in TCP 
Modbus ASCII in TCP message format is exactly same as that of the Modbus ASCII 
protocol. The main difference is that Modbus ASCII in TCP protocol communicates with a 
SCADAPack controller through the Internet and Modbus ASCII through the serial port. The 
Modbus ASCII in TCP protocol does not include a six-byte header prefix, as with the 
Modbus\TCP, but does include the Modbus ‘CRC-16’ or ‘LRC’ check fields.  
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• To configure a Modbus ASCII in TCP protocol connection, highlight Modbus ASCII in 
TCP in the Communication Protocols window and click the Configure button. The 
Modbus ASCII in TCP Configuration window is displayed. 

• To select a configured Modbus ASCII in TCP protocol connection, highlight Modbus 
ASCII in TCP in the Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus ASCII in TCP is selected for configuration the Modbus ASCII in TCP 
Configuration dialog is opened with the General tab selected as shown below.  

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

SCADALog User and Reference Manual  
March 10, 2006 

48



The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 

127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The TCP Port No. field specifies the TCP port of the remote device. Valid values are 0 to 
65535. The default value is 49153. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 
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The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 
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The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus ASCII in UDP 
Modbus ASCII in UDP protocol is similar to Modbus ASCII in TCP protocol. It has the same 
message format as the Modbus ASCII in TCP. The only difference between them is one 
uses TCP protocol and another uses UDP protocol. 

• To configure a Modbus ASCII in TCP protocol connection, highlight Modbus ASCII in 
UDP in the Communication Protocols window and click the Configure button. The 
Modbus ASCII in UDP Configuration window is displayed. 

• To select a configured Modbus ASCII in TCP protocol connection, highlight Modbus 
ASCII in UDP in the Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 
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General Parameters 
When Modbus ASCII in UDP is selected for configuration the Modbus ASCII in UDP 
Configuration dialog is opened with the General tab selected as shown below.  

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 
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127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The UDP Port No. field specifies the UDP port of the remote device. Valid values are 0 to 
65535. The default value is 49153. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
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if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus RTU 

Introduction 
The Modbus RTU protocol driver is used to communicate over a serial network, using 
Modbus RTU framing, to SCADAPack controllers configured for Modbus RTU protocol.  
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• To configure a Modbus RTU protocol connection, highlight Modbus RTU in the 
Communication Protocols window and click the Configure button. The Modbus RTU 
Configuration window is displayed. 

• To select a configured Modbus RTU protocol connection, highlight Modbus RTU in the 
Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus RTU is selected for configuration the Modbus RTU Configuration dialog is 
opened with the General tab selected as shown below.  

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 
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The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

This Serial Port Settings grouping contains details directly related to the PC’s 
communication port including the port number, the baud rate, parity and stop bit settings.  

The Port parameter specifies the PC serial port to use. The DNP driver determines what 
serial ports are available on the PC and presents these in the drop-down menu list. The 
available serial ports list will include any USB to serial converters used on the PC. The 
default value is the first existing port found by the driver.  

The Baud parameter specifies the baud rate to use for communication. The menu list 
displays selections for 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, and 57600. The 
default value is 9600. 

The Parity parameter specifies the type of parity to use for communication. The menu list 
displays selections for none, odd and even parity. The default value is None. 

The Stop Bits parameter specifies the number of stop bits to use for communication. The 
menu list displays selections for 1 and 2 stop bits. The default value is 1 bit. 

The Connection Type parameter specifies the serial connection type. The Modbus RTU 
driver supports direct serial connection with no flow control, Request-to-send (RTS) and 
clear-to-send (CTS) flow control and PSTN dial-up connections. The menu list displays 
selections for Direct Connection, RTS/CTS Flow Control and Dial Up Connection. The 
default selection is Direct Connection. 

• Select Direct Connection for RS-232 for RS-485 connections that do not require the 
hardware control lines on the serial ports.  

• Select RTS/CTS Flow Control to communicate over radio or leased-line networks using 
modems that require RTS/CTS handshaking. Selecting RTS/CTS Flow Control adds a 
new tab, Flow Control, to the Modbus RTU Configuration dialog. Refer to the Flow 
Control Parameters section below for configuration details.  

• Select Dial Up Connection to communication over dial up modems. Selecting Dial Up 
Connection adds a new tab, Dial Up, to the Modbus RTU Configuration dialog. Refer to 
the Dial Up Parameters section below for configuration details. 

• Click Restore Defaults to restore default values to all fields on this page. 

Modbus RTU Configuration (Flow Control) 
Flow Control parameters are used to configure how RTS and CTS control is used. When 
RTS/CTS Flow Control is selected for Connection Type the Flow Control tab is added to the 
Modbus RTU Configuration dialog.  When the Flow Control tab heading is clicked the Flow 
Control dialog is opened as shown below. 
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The RTS/CTS Flow Control grouping contains two mutually exclusive options, Use 
Hardware Control Lines and Use CTS Delay Time.  These options enable the driver to 
communicate over radio or leased-line networks using modems that require RTS/CTS 
handshaking.  

The Use Hardware Control Lines option specifies a half-duplex connection requiring the 
use of the Request to Send (RTS) and Clear to Send (CTS) hardware control lines to control 
the flow of data. This selection is used with radios and dedicated telephone line modems. 
The driver turns on the RTS signal when it wants to transmit data. The modem or other 
device then turns on CTS when it is ready to transmit. The driver transmits the data, and 
then turns off the RTS signal. This selection is mutually exclusive of the Use CTS Delay 
Time selection described below. This is the default selection. 

The Use CTS Delay Time option is selected if the device cannot generate a CTS signal. 
The driver will assert RTS then wait the specified Delay Time, in milliseconds, before 
proceeding.  This option is mutually exclusive with the Use Hardware Control Lines selection 
described above. 

The Delay Time parameter sets the time in milliseconds that the driver will wait after 
asserting RTS before proceeding. The value of this field must be smaller than the Time Out 
value set in the General parameters dialog. For example, if the Timeout value is set to 3 
seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 

The Hold Time parameter specifies the time, in milliseconds, that the driver will hold RTS 
after the last character is transmitted. This is useful for devices that immediately end 
transmission when RTS is turned off. The value of this field must be smaller than the Time 
Out value set in the General parameters dialog. For example, if the Timeout value is set to 3 
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seconds, the CTS Delay Time can be set to 2999 milliseconds or less. The minimum value 
for this field is 0 milliseconds. The value is initially set to 0 by default. 

• Click Restore Defaults to restore default values to all fields on this page. 

Modbus RTU Configuration (Dial Up) 
Dial Up parameters are used to configure a dial up connection. When Dial Up is selected for 
Connection Type the Dial Up tab is added to the Modbus RTU Configuration dialog.  When 
the Dial Up tab heading is clicked the Dial Up dialog is opened as shown below. 

 
The Dialing Prefix parameter specifies the commands sent to the modem before dialing. A 
maximum of 32 characters can be entered. All characters are valid. The default value is 
“&F0 &K0 S0=1 &W0 &Y0”. 

The Phone Number parameter specifies the telephone number of the remote controller. A 
maximum of 32 characters can be entered. All characters are valid. This field’s default value 
is blank. 

The Dial Type parameter specifies the dialing type. Valid values are Pulse and Tone. The 
default value is Tone. 

The Dial Attempts parameter specifies how many dialing attempts will be made. Valid 
values are 1 to 10. The default value is 1.  

The Connect Time parameter specifies the amount of time in seconds the modem will wait 
for a connection. Valid values are 6 to 300. The default value is 60. 
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The Pause Time parameter specifies the time in seconds between dialing attempts. Valid 
values are 6 to 600. The default value is 30. 

Check the Inactivity Timeout check box to automatically terminate the dialup connection 
after a period of inactivity. The Inactivity Time edit box is enabled only if this option is 
checked. The default state is checked. 

Enter the inactivity period, in minutes, in the Inactivity Timeout box. The dialup connection 
will be terminated automatically after the specified number of minutes of inactivity has 
lapsed. This option is only active if the Inactivity Timeout box is checked. Valid values are 
from 1 to 30 minutes. The default value is 1. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
Phone Number field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 

SCADALog User and Reference Manual  
March 10, 2006 

59



increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 
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Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus RTU in TCP 
Modbus RTU in TCP message format is exactly same as that of the Modbus RTU protocol. 
The main difference is that Modbus RTU in TCP protocol communicates with a controller 
through the Internet and Modbus RTU protocol through the serial port. The Modbus RTU in 
TCP protocol does not include a six-byte header prefix, as with the Modbus\TCP, but does 
include the Modbus ‘CRC-16’ or ‘LRC’ check fields. The Modbus RTU in TCP message 
format supports Modbus RTU message format. 

• To configure a Modbus RTU in TCP protocol connection, highlight Modbus RTU in TCP 
in the Communication Protocols window and click the Configure button. The Modbus 
RTU in TCP Configuration window is displayed. 

• To select a configured Modbus RTU in TCP protocol connection, highlight Modbus RTU 
in TCP in the Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus RTU in TCP is selected for configuration the Modbus RTU in TCP 
Configuration dialog is opened with the General tab selected as shown below. 

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  
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The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 

127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The TCP Port No. field specifies the TCP port of the remote device. Valid values are 0 to 
65535. The default value is 49152. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 
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The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 
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The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus RTU in UDP 
Modbus RTU in UDP protocol is similar to Modbus RTU in TCP protocol. It has the same 
message format as the RTU in TCP message. The only difference between them is one 
uses TCP protocol and another uses UDP protocol.  

• To configure a Modbus RTU in UDP protocol connection, highlight Modbus RTU in 
UDP in the Communication Protocols window and click the Configure button. The 
Modbus RTU in UDP Configuration window is displayed. 

• To select a configured Modbus RTU in UDP protocol connection, highlight Modbus RTU 
in UDP in the Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
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When Modbus RTU in UDP is selected for configuration the Modbus RTU in UDP 
Configuration dialog is opened with the General tab selected as shown below. 

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 

SCADALog User and Reference Manual  
March 10, 2006 

65



127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The UDP Port No. field specifies the UDP port of the remote device. Valid values are 0 to 
65535. The default value is 49152. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 250 when Addressing is set to Extended and Station is 
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255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 252. When Addressing is set to Standard valid values are 2 to 252. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus/TCP 
Modbus/TCP is an extension of serial Modbus, which defines how Modbus messages are 
encoded within and transported over TCP/IP-based networks.  The Modbus/TCP protocol 
uses a custom Modbus protocol layer on top of the TCP protocol. Its request and response 
messages are prefixed by six bytes. These six bytes consist of three fields: transaction ID 
field, protocol ID field and length field. The encapsulated Modbus message has exactly the 
same layout and meaning, from the function code to the end of the data portion, as other 
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Modbus messages. The Modbus ‘CRC-16’ or ‘LRC’ check fields are not used in 
Modbus/TCP. The TCP/IP and link layer (e.g. Ethernet) checksum mechanisms instead are 
used to verify accurate delivery of the packet. 

• To configure a Modbus/TCP protocol connection, highlight Modbus/TCP in the 
Communication Protocols window and click the Configure button. The Modbus/TCP 
Configuration window is displayed. 

• To select a configured Modbus/TCP protocol connection, highlight Modbus/TCP in the 
Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus/TCP is selected for configuration the Modbus/TCP Configuration dialog is 
opened with the General tab selected as shown below. 

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 
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The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 

127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The TCP Port No. field specifies the UDP port of the remote device. Valid values are 0 to 
65535. The default value is 502. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 
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The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 246 when Addressing is set to Extended and Station is 
255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 248. When Addressing is set to Standard valid values are 2 to 248. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 
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The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus/UDP 
Modbus/UDP communication mode is similar to Modbus/TCP communication mode. It has 
the same message format with the Modbus/TCP. The only difference between them is one 
uses TCP protocol and another uses UDP protocol.  

• To configure a Modbus/UDP protocol connection, highlight Modbus/UDP in the 
Communication Protocols window and click the Configure button. The Modbus/ UDP 
Configuration window is displayed. 

• To select a configured Modbus/UDP protocol connection, highlight Modbus/ UDP in the 
Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 
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General Parameters 
When Modbus/UDP is selected for configuration the Modbus/ UDP Configuration dialog is 
opened with the General tab selected as shown below. 

 
The Modbus Communication Settings grouping contains Modbus specific communication 
settings including the addressing mode, the station address, the timeout interval as well as 
the number of attempts.  

The Addressing parameter selects standard or extended Modbus addressing. Standard 
addressing allows 255 stations and is compatible with standard Modbus devices. Extended 
addressing allows 65534 stations, with stations 1 to 254 compatible with standard Modbus 
devices. The default is Standard. 

The Station parameter sets the target station number. The valid range is 1 to 255 if 
standard addressing is used, and 1 to 65534 if extended addressing is used. The default is 
1. 

The Timeout parameter sets the length of time, in seconds, to wait for a response from the 
controller before retrying (see Attempts), or ultimately failing. Valid entries are 1 to 255. The 
default is 3. 

The Attempts parameter sets number of times to send a command to the controller before 
giving up and reporting this failure to the host application. Valid entries are 1 to 20. The 
default is 3. 

The Host Network Details grouping contains entries for the host’s IP address or name and 
the TCP port on which it is listening.  

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 
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127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 

The UDP Port No. field specifies the UDP port of the remote device. Valid values are 0 to 
65535. The default value is 502. 

• Click Restore Defaults to restore default values to all fields on this page, except for the 
IP Address / Name field. The content of this field will remain unchanged. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 246 when Addressing is set to Extended and Station is 
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255 or higher. When Addressing is set to Extended and Station is less than 255 valid values 
are 2 to 248. When Addressing is set to Standard valid values are 2 to 248. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Modbus/USB 
The Modbus/USB protocol specifies a Universal Serial Bus (USB) connection between 
SCADAPack controllers equipped with a USB peripheral port and the PC. 

Note:  Windows NT does not support USB. The Modbus/USB selection will be displayed 
but it will not work with Windows NT. This is a limitation of the Windows NT 
operating system. 
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• To configure a Modbus/USB protocol connection, highlight Modbus/USB in the 
Communication Protocols window and click the Configure button. The Modbus/USB 
Configuration window is displayed. 

• To select a configured Modbus/USB protocol connection, highlight Modbus/USB in the 
Communication Protocols window and click the OK button. 

• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When Modbus/USB is selected for configuration the Modbus/USB Configuration dialog is 
opened with the General tab selected as shown below. 

 
The Connection Settings grouping presents two options for Modbus/USB connections. 
These options are Automatic Connection and Connect to controller with this Controller ID.  

Automatic Connection 

The Automatic Connection selection enables communication with any single SCADAPack 
controller equipped with a USB peripheral port. An error message, as shown below, is 
displayed when more than one SCADAPack controller is detected on the Bus.  

 
The Connect to controller with this Controller ID selection enables Modbus/USB 
communication to a specific controller regardless of the existence of multiple controllers on 
the bus. Each SCADAPack controller is uniquely identified through its Controller ID.  

The Controller ID list box will display the Controller ID for each controller on the Bus. The 
Controller ID may be entered in the entry window or selected from the list. 
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The Restore Defaults button will restore the configuration dialog to the default state. The 
Automatic Connection option is selected, and the Connect to controller with this Controller ID 
selection will be disabled. If text was present in the Controller ID window when the button is 
pressed it will be displayed in grey. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 

 
The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

SCADAServer 
The SCADAServer protocol specifies a SCADAServer Host connection. Applications will act 
as an OPC client and route all programming commands through the SCADAServer Host to 
the SCADAPack controller. The type of connection to the field device: no flow control, 
hardware flow control or dial-up modem is configured in the SCADAServer Host itself. 

• To configure a SCADAServer protocol connection, highlight SCADAServer in the 
Communication Protocols window and click the Configure button. The SCADAServer 
Configuration window is displayed. 

• To select a configured SCADAServer protocol connection, highlight SCADAServer in 
the Communication Protocols window and click the OK button. 
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• To close the dialog, without making a selection click the Cancel button. 

General Parameters 
When SCADAServer is selected for configuration the SCADAServer Configuration dialog is 
opened with the General tab selected as shown below. 

 
The Communication Settings grouping contains all essential details necessary to establish 
communication to a device through a local or remote SCADAServer installation.  

The Modbus Station parameter specifies the station address of the target device. The valid 
range is 1 to 65534. The default is station 1. 

The Access Path parameter specifies the access path to a SCADAServer connection. This 
parameter is entered as a string with a maximum size of 16 characters. This access path 
was named when a connection was defined within the SCADAServer installation. If the 
access path is left blank, the default SCADAServer connection will be used, as defined 
within the SCADAServer installation. The default for this entry is blank. 

The Use a remote server check box defines whether the SCADAServer connection uses a 
SCADAServer installation installed on the same physical PC as the client application or on a 
remote PC.  If the SCADAServer installation is located on a separate machine, check this 
option and enter the host name or IP address of the remote PC into the “IP Address / Name” 
edit box. If the SCADAServer installation is located on the same PC as the client application 
leave this box unchecked. The default state for this check box is unchecked. 

The IP Address / Name entry specifies the Ethernet IP address in dotted quad notation, or a 
DNS host name that can be resolved to an IP address, of the PC where the ClearSCADA 
server is installed. The following IP addresses are not supported and will be rejected: 

0.0.0.0 through 0.255.255.255 

127.0.0.0 through 127.255.255.255 (except 127.0.0.1) 

224.0.0.0 through 224.255.255.255 

255.0.0.0 through 255.255.255.255. 
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• Click Restore Defaults to restore default values to all fields on this page. 

Advanced Parameters 
Advanced parameters are used to control the message size for the protocol. Control over 
message length is needed when writing large amounts of data over certain communication 
networks. A larger value can improve communication speed but can increase the number of 
failed transmissions. A smaller value can reduce the number of failed transmissions but may 
reduce throughput. When the Advanced tab heading is clicked the Advanced dialog is 
opened as shown below. 

 
The Message Size grouping parameters are used to control the message size for the 
protocol. Control over message length is needed when writing large amounts of data over 
certain communication networks. A larger value can improve communication speed but can 
increase the number of failed transmissions. A smaller value can reduce the number of 
failed transmissions but may reduce throughput.  

The Maximum selection indicates that the host application is to package messages using 
the maximum size allowable by the protocol. 

The Custom Value selection specifies a custom value for the message size. This value 
indicates to the host application to package messages to be no larger than what is specified, 
if it is possible.  Valid values are 2 to 246. 

• Click Restore Defaults to restore default values to all fields on this page. 

Information 
Information displays detailed driver information. When the Information tab heading is clicked 
the Information dialog is opened as shown below. 
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The Information grouping presents informative details concerning the executing protocol 
driver. 

Module is the physical name of the driver. 

File Version is the version number of the driver. 

In GAC indicates whether the module (assembly) was loaded from the Global Assembly 
Cache (GAC). 

Runtime is the version of the Common Language Runtime (CLR) the driver was built 
against. 

Copyright indicates the copyright information of the protocol driver. 

Connect to Controller Command 
The Connect to Controller command starts a dial-up connection to a remote Flow Computer. 
To connect to a dial-up flow computer, select Connect to Controller from the 
Communication menu. Wait for RealFLO to connect to the remote Flow Computer. 

Disconnect from Controller Command 
The Disconnect from Controller command terminates a dial-up connection. To disconnect 
from a dial-up Flow Computer select Disconnect From Controller from the 
Communication menu. Wait for RealFLO to disconnect with the remote Flow Computer. 

Communication Progress Dialog 
The Communication Progress dialog is displayed whenever RealFLO is communicating with 
the Flow Computer. The dialog indicates the operation being performed and the status of the 
communication. If a long operation is being performed, a progress bar is displayed as well. 

Click on the Cancel button to abort the operation. This is useful if communication is not 
progressing or if you have initiated the operation in error. 
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Communication Failures 
Communication with the Flow Computer may fail for one of the following reasons. 

• The message to the Flow Computer was garbled or lost by the communication network. 

• The response from the Flow Computer was garbled or lost by the communication 
network. 

• The Flow Computer is not connected. 

• The PC Serial Port Settings are not set correctly. 

• The Flow Computer did not respond or responded too late. Setting the time-out value 
too small in the PC Communications Settings can cause this. 

If communication fails a message box appears. You have two options: 

Select Retry to attempt the communication again. This is most useful when an occasional 
message is garbled by the communication system. 

Select Cancel to abort the command. Select this if all retry attempts fail. Correct the source 
of the problem and retry the command. 

Inactive Phone Connection Dialog 
The Inactive Phone Connection dialog is displayed when a dial-up phone connection has 
been inactive for longer than the period set in PC Communications Settings. The dialog 
warns that the connection will be terminated. 

Click on OK to terminate the connection immediately. 

Click on Cancel to stay connected. 

Window Menu 
The Window menu contains the commands for opening and arranging all windows used in 
SCADALog. 

New Window Command 
Use this command to create a copy of the currently selected window. You can change the 
view in the copy of the window so you can look at more than one view at a time. 

Cascade Command 
Use this command to arrange all open, non-minimized windows, so they stack upon each 
other with an offset so the title bar of each window is visible. All minimized windows are 
collected at the bottom of the main window. 

Tile Command 
Use this command to arrange all open, non-minimized windows, so that all are visible. All 
minimized windows are collected at the bottom of the main window. 

Arrange All Command 
Use this command to arrange all icons (minimized windows) at the bottom of the main 
window. 
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Open Window List 
Use the numbers and filenames listed at the bottom of the Window menu to switch to any 
open window. Choose the number that corresponds with the window you want to activate. 

If there are more than nine open windows, the last item in the open window list will be the 
command More Windows. This will open a dialog with a list box showing all open windows. 

Help Menu 
The Help menu contains the commands for opening and using SCADALog on line help and 
for viewing information about SCADALog. 

Contents Command 
Use this command to open the SCADALog help file using the Windows Help program. The 
Contents page of the help file is displayed.  

The help file has a general description of how the SCADALog program operates and how to 
use the SCADALog program. It also has specific descriptions for each view, dialog and 
command. 

About Command 
Use this command to display information about SCADALog. 

Script Execution 
SCADALog Script files, created with the Edit Script command can be executed in two 
modes: automatic mode and manual mode. 

Automatic mode 
Automatic mode allows the user to configure other applications to execute the SCADALog 
script command automatically. Direct user-operation of SCADALog is not necessary in this 
scenario. SCADALog is completely run by another application. 

To run the script automatically, a command line has to be configured in the user application. 
The command line is in following format: 
SCADALog configfile.slc [/s=scriptfile.aut [/NoWindow]] 

where /NoWindow is an option.   

If the command line doesn’t include the /NoWindow option, the SCADALog application 
window is displayed during the execution of the script, and a communication dialog allows 
the user to cancel the current operation at any time. 

If the command line includes the /NoWindow option, the SCADALog application window is 
not displayed during script running, and the user can’t abort the script execution before it is 
completed. 

As an example, the following command line, entered in a DOS prompt, will execute the 
commands contained in the script file demolog.aut in a SCADALog application called 
demo.slc. The SCADALog application will not be displayed during the script file execution. 

SCADALog demo.slc /s=demolog.aut /NoWindow 

As a further example, the following command line will execute the commands contained in 
the script file log1.aut in a SCADALog application called logtest.slc. The SCADALog 
application will be displayed during the script file execution. 
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SCADALog logtest.slc /s=log1.aut 

Manual mode 
Manual mode allows the user to execute a SCADALog script command manually from the 
Read Logs dialog. Refer to the Read Logs Command section for more detailed 
information. 

Error processing 
If an error occurs in automatic mode with the /NoWindow option enabled, SCADALog will 
exit. 

If an error occurs in automatic mode with the /NoWindow option disabled, an error message 
dialog will be displayed. Selecting the OK button will exit SCADALog. 

If an error occurs in manual mode, an error message dialog will be displayed. Selecting the 
OK button will close the dialog and return SCADALog to the main menu control. 

Log Results File 
Results of the reading of data logs may be saved to a log file. This log can be used to 
monitor the operation of automated script execution or to maintain a history of logs read. 

The user can set whether or not results are logged. See the Log Results command section 
for more information. 

The results are saved in a text file as filename.LOG in the subdirectory where the 
SCADALog configuration file filename.slc resides. 

The format of the log file is: 

The log information consists of three parts as follows: 

Date & Time stamp Operation Result 

The Date & Time stamp indicates the date and time at the end of the operation. The date is 
recorded using the short date format defined in the Control Panel. The time is recorded 
using the time format defined in the Control Panel. 

The Operation indicates the script command that was executed. 

The Result indicates the normal result or error message. 

Example: 

2001/07/16 14:35:13 -- Read Log 1 -- 14 new records, 0 discarded records 

2001/07/16 14:35:15 -- Read Log 2 -- 50 new records, 0 discarded records 

2001/07/16 14:35:15 -- Save 

2001/07/16 14:35:15 -- Exit 
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